ber systems

TRAINING KIT

Synergy

Synergy Mill Manual

Weber Systems, Inc.
W134 N5514 Campbell Drive Menomonee Falls W1 53051
Phone: (262) 782-0181 / Fax: (262) 782-3191
www.webersys.com



Synergy Mill

Synergy Mill

Training Manual

Synergy Training 2 Weber Systems, Inc.



Synergy Mill

Table of Contents

SYNERGY MILL

TABLE OF CONTENTS

INTRODUCTION

ABOUT THIS GUIDE

CONVENTIONS USED IN THIS HANDBOOK
MOUSE NOTATION

TEXT NOTATION

MENU NOTATION

SYNERGY'S FILE STRUCTURE
INTRODUCTION TO THE INTERFACE
THE FILE MENU

THE EDIT MENU

THE MISC MENU

THE PROPERTY MENU

THE SHOW MENU

ON-OFF SWITCHES

THE INQUIRE MENU

THE INFO MENU

WORKING WITH THE GRAPHICS MENU
INPUT OPTIONS

DYNAMIC INPUT MODE

DYNAMIC INPUT KEYBOARD SHORTCUTS

EXERCISE 1: CIRCLES AND HOLES WITH DIMENSIONS

CONSTRUCT OUTSIDE CONTOUR
CONSTRUCT INSIDE CONTOUR
PLACE CIRCLES

AUTOLINKING

INTRODUCTION TO THE ARCHIVE
REVIEW DRAWING EXERCISE 1
APPLYING HOLE FEATURES
GENERATE CUTTER PATHS
TURBOPOST THE JOB

NC DOCUMENTATION
RE-ARCHIVE THE JOB

EXERCISE 2: ADVANCED 2D
CONSTRUCT OUTSIDE GEOMETRY
CONSTRUCT LARGE POCKET
AUTOLINK CONTOUR
DIMENSIONING

EXERCISE 2 MANUFACTURING
POCKET MILLING

GENERATE NC CODE

RUNNING AMO

DATA EXCHANGE IGES

THE IGES WIDGET

IGES ENTITIES

DXF

TOOL LIBRARIES

UTILITY KITS

USER DEFINED HOTKEYS

Synergy Training

Weber Systems, Inc.



Synergy Mill

EXERCISE 3: TRIMMING 62
COPYRIGHTS 63

Synergy Training 4 Weber Systems, Inc.



Synergy Mill

Introduction

Welcome to Weber System’s Synergy CAD/CAM Softwargme®gy combines the world’s most powerful
CAD/CAM automation tool with a specialized interfacemed at the manufacturing professional.

Weber’s flagship product, Synergy, has the ability &ate CNC programming code for almost all types of
production machining. Synergy has the unique capacity to pestandardized processes that reflect a
company’s specific needs. Manufacturers around the gligbasing Synergy to produce quality CNC
programs, using fewer resources, faster than ever before.

About this Guide

The Synergy Mill handbook contains detailed informatiooualWeber System’s Synergy tools and
commands. We have designed this handbook to be used asydagvesference tool in your work with

Synergy.

This guide assumes you have a working knowledge of your comgndet's operating conventions,
including how to use a mouse and standard menus and commands.

Conventions Used in this Handbook

Mouse Notation

Click Press and release the primary mouse button. Forpaopte, this will be the
left-button.

Right-Click Press and release the secondary mouse button. Tisisaly the button to
farthest right on your mouse.

Middle-Click Press and release the middle mouse button.

Double-Click Some what rapidly, press and release the mouse lufitan

Drag Move the mouse as you press and hold the mouse button.

Text Notation

<Space> (Or any other keystroke...) Press the key indicagtgtden the <> symbols. In this case,
you would press the spacebar. Any instructions that reqotation of non-printing keystrokes will be set
off by <> symbols. For example: <Esc>, <Enter>, or <8Bpace>

<Shift> + <R> (Or any other keystroke combination...) Sometimésnecessary to press two keys at
once. This will be represented by two keystrokes jolmed plus (+) sign. This notation means that you
should press the <Shift> and <R> keys at the same time.

<Shift>, <R> (Or any other keystroke combination...) A comma s@éparate keystrokes that should be
pressed in sequence. This notation means that you showd@edt>, release it, and then press <R>.

<Shift>+Click  Press and hold the Shift (or any other keystroke)ewdu press and release the mouse
button.

> The> symbol indicates a chain of menus that you will navigstelicking. For
example, you begin shutting the system down by clicking-FilExit from the main menu. This notation
means that you should click the word File on the main raewlithen click Exit from the file drop down
menu.
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Menu Notation
Drop Down A drop down menu is the kind of menu that appears ued#hran area after you click it.
The majority of Synergy’s menus are drop down menus.

Pop Up Menu A pop up menu is just like a drop down menu, except that itappenen you click in a
certain area or in a certain way. For example, rigbkiolg on an icon on the Windows NT desktop will

bring up a pop up menu.

Synergy Training 6 Weber Systems, Inc.
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Synergy’s File Structure

Synergy stores all of its necessary files in a regigtedirectory structure. All of the following directesi
reside unde€:\usr\weber\.

ARCHIVE

This is the default location for the Synergy's storAgehive. The file archive is designed to store the
synergy file along with all associated file componentis a directory structure.

WEBDEF
This directory contains interface files that work amjuinction with the guidef files.

UTIL
Tools and materials, data and plotter configuraiies fjo in this directory.

USER DATA
This directory stores miscellaneous information anxiliary data.

TMP
This is the temporary directory used by the system.

POST_FORMATS
Common post processors are stored in this directory.

HTTP
This directory contains all of the Netscape-help etaddes and data.

GUIDEF
This directory contains customizable Graphic Usesrfate (GUI) definition scripts.

ETC
Output files that get copied to the bin directory areestan this directory.

DATABASE
The Database directory contains strategies and meassgeby the system.

CONTRIB
This directory acts as a Depository for customizedpasat is for unsupported material that isn’t updated.

BITMAPS

This directory contains bitmaps for the interfacese pittures and backgrounds that you see on the
buttons go here.

BIN
The BIN directory contains binary executable files.

ASCRPT
The Synergy script library base for the system isestin this directory.
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SCHEMAS
This directory holds files that the system needs tgarsolids.

ST

This is the default storage directory for Synergy. Wihenuser does &aveor Save As this is
where the files get stored. This directory can edslynapped to a different location.
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Introduction to the Interface

Throughout Synergy’s documentation, specific terminology sefespecific areas of the screen. These
areas are illustrated in the image below.

Main Menu Tab Menus

|— _{/Grogannt/C/uzifweber/ aichive/glsamplefievizion /synfile
Seftings  Property  Show  Inquire Info & W * Help

Title Bar: —>

Prompt line > ? | Construct | Rits | wtitt | Tum | 20 mach | 30 | Advan | Drating | beentrol
i /d' | j Foints Lines Circles Holes Splines Curves Trim Macros
Input Line = =
B BT W TTERTTT R TR B BEWECT] Cxls ozl 2| |[0 soia ___~|[Rectangutar =l[End Pt ]
Color Controls iew Refresh Zoom Render Drawings Yiew 1 View 2 View 3 View 4 Yiew 5

Graphics Menu

Layer Controls LineType Controls Input Controls

Raising the Tab menus

Synergy is divided in to four basic systems, Designija#ianal, Solids and Variational Solids. Each system is
accessed through the Tab Menus. Four buttons are providadé the appropriate system.

To raise the Design D tabs, click D
To raise the Variational tabs, click V
To raise the Solid Modeling tabs, clik
To raise the Variational Solid Modeglitabs, click V/S
Utility Kits
The Synergy user configured Utility Kits are raised in&gy by clicking on them from tha menu.
Undocking menus
Menus other than the main and graphics menus can be kedidcom their default locations. Clicking and
dragging a menu on any non-button area will undock the mediyou can move it around the screen. Menus will
automatically snap to the edges of the screen, orawcltoose to have the menus “float” freely.
The “except” check box
The visible Colors/Layers can be inverted by use of*dlkeept” check box.. When the box is checked, the "except”
mode is active.
Color Change Buttons

TheEntity, Box, Contour andinherit buttons have been integrated into a pop up menu accessgttimticking
on the area on the far left of the color controls thdicates the active color.
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Synergy’s File Menu

Main Menu: File = New

Synergy will ask you to confirm that you want to startew job. Enter "Y" to start a new file, enter "N" t
abort procedure. Then you will have the opportunity t& ie CAD settings that you are going to use in
the next file. CAD settings are predefined system vhriséttings that are used to determine things like
measurements, scales, and other variables.

Main Menu: File = Open
This command can open an entire Synergy file, or jestitdis geometry or TurboPost info.

» Enter [E] to open the entire Synergy File

» Enter [G] to open just the file’s geometry

» Enter [T] to open only the file’s TurboPost inforneeti
* Enter [N] to cancel the open procedure.

» Enter [C] to open the NC Tape

Main Menu: File - Merge - Current Position

This command reads a file and places it at its origotation. Enter [U] to undo the file placement. Enter
[M] to finalize the merge.

Main Menu: File - Merge - Reposition in 2D

This command reads a file and places it in severalitweain 2D Enter [U] to undo the file placement.
Enter [P] to finalize the merge.

Main Menu: File - Merge - Reposition in 3D

This command reads a file and places it in severalitweain 3D Enter [U] to undo the file
placement. Enter [P] to finalize the merge.

Main Menu: File - Merge - Graphical
This command reads a file and allows the user to grdjhptace it.
Main Menu: File - Archive

The file archive is designed to store the Synergyafibeg with all associated file components into a
directory.

Main Menu: File = Save

This command saves a file into the current locatiéou are encouraged to use our Archive system rather
than this method of file storage.

» Enter [E] to save the entire Synergy file.

» Enter [G] to save only the drafting geometry of tihe f
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Main Menu: File = Save As

This command saves a file to a desired location, dag/¢el enter a name and description for the file. You
are encouraged to use our Archive system rather tham#tineod of file storage.

» Enter [E] to save the entire Synergy file.

» Enter [G] to save only the drafting geometry of tihe f

Main Menu: File - Work Space
This will allow you to work in two sessions of Synemyonce. You can switch back and forth by choosing
primary and secondary. Primary and secondary are tatapendent of each other.

Main Menu: File - Copy File
This command will make a duplicate of a file.

Main Menu: File = Delete File
This command will delete a file.

Main Menu: File = Import

This is where a user can import an IGES file, DXFdile Prompt External. A Prompt external is
geometry data created in Weber System’s first genersditware called Prompt.

Main Menu: File - Export
This is where a user can Export out of Synergy, an I@E8rfa CNC program either stored down in a
Synergy file or just created.

Main Menu: File - Exit Main Menu: File - Exit
This is the recommended command for exiting the Syneystem.
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The Edit Menu

Main Menu: Edit & Undo / Redo
Synergy has the ability to undo and redany, but not all actions.

You can tell when an action can be undone by checkingrttie buttorafter you have performed the

action. If the last action may be undone, the undo bugtactive. If there are no actions in the undo louffe
or Synergy is in the middle of performing an action,uhdo button appears faded. Actions that may not be
undone will clear the undo buffer and the undo button withlbak.

Limitations -- Functions that can be undone

* Most geometric constructions both 2d and 3d

* Most entity trimming functions

* Most rotate, invert, move, copy, scale, and projeattions

* Most drafting entities and geometric tolerance featuxe$o

* Most delete functions, except for deleting all of a d¢ertige of entity (for example:
Delete all surfaces), or deleting variational recandsbjects

* Most editing of dimension entities can be undone. Excep#tuwlits which involve all
dimensions cannot be undone

» Creation of cutter paths for lathe, 2d, 3d and mulg-exachining

* Modification of contours such as corner radii, lead-aghamfers

* Placing a hole feature in VDM, however, reading the li@hture can not be undone

Functions that cannot be undone

» Edits which involve all dimensions cannot be undone

» Deleting all of a certain type of entity (for example:atelall surfaces)
» Deleting variational records or objects

* Modifying variational records, changing variables or fremapeeters.
* Auto-linking a contour

* Manually linking a contour

* Unlinking an entity, dimension, group or contour

e Saving and archiving

» Embedding a file or execution of a thread in VDM

» Creation or modifying a variable value

» Assignment of tools, work zones, info packets and iterpepti@s

» Creating, modifying or deleting a boundary

» Creating, modifying or deleting an area fill

» Creating or deleting a VDM Object

* Plotting, zooming, viewing, and other graphical fuocs

* Changing of system settings

* Recalculation of 2d or 3d cutterpaths in a non-vdm envirohmen
* Modification of 3d cutterpath entities

* Executing a strategy in VDM

» Executing all in VDM

» Executing an object in VDM

* Delete last record in VDM

* Reading a hole feature in VDM, however, placing the li@hture can be undone.
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Main Menu: Edit = Delete

Use the commands listed under this menu to remove ftemsyour geometry. Delete can remove a
single entity, multiple entities, all the entities, &a8 in a box. It can also delete items by property (line
type, color, layers, etc...).

Main Menu: Edit - Delete-> Property

You will find commands under this menu for deleting propersash as tools, operations, material and
workzone data.

Delete an area fill by selecting Main Meritdit - Delete-> Property > Area Fill

Main Menu: Edit - Delete-> Group

This sub-menu contains commands for deleting groupshargktthat synergy considers groups. This
includes: Contours, Names, Plot Groups, Tool Images, andri3ions. This menu also contains the
commands for unlinking linked contours.

Main Menu: Edit - Delete-> Types
This submenus contains the special delete commands thaggduause if you are working with types.

Main Menu: Edit & Geometry

This menu contains commands that you will use when yamt ¥ make changes to existing geometry.
You will find commands for making changes to Dimensiomsg] Eoints, control points, weights, hole
depths, and diameters. You will also find the commaadstfetching geometry under this menu.

Main Menu: Edit - Tool Library

When working with, creating, or changing your tool dity;, you'll need the commands located in this
submenu.

Main Menu: Edit - Types
When working wit Types, you'll need the commands locatgtiis submenu.

Main Menu: Edit = User Constants

This will allow a user to customize Synergy by settiefaults. An example may be mapping the storage
directory to another drive. Once this file is chandegkts stored down to /usr/weber/contrib./ascrpt/ and
will never get over written by an update.

Main Menu: Edit - File Info
This command gives you access to the file header. ¥olinaited to 4096 characters in the file header.

Main Menu: Edit - Execute Script

This will allow a user to execute a script that mat/lattached to a button. The script must be located
under /usr/weber/ascrpt.

Main Menu: Edit - Last Scripts

This command with give you a list of the scripts theténbeen run recently. You can pick a script name
and re-execute the script.

Main Menu: Edit - Script
This is a way to edit a script from within Synergy.
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Main Menu: Edit = Interface

These commands are used for creating custom Synergy naoiusts, or also referred to as Utility Kits.
See the section on utility kits for more details.

The Misc Menu

Main Menu: Misc - Re-Start
Use this command when you need to get out of an erromier§y.

Main Menu: Misc - Leave Script
Use this command when you want to exit a script withootpeting it.

Main Menu: Misc - Redo Last Operation

This command should really be named “Repeat” Last Gparafhis command repeats the last non-
variational hole operation performed.

Main Menu: Misc = Calculator & Term Window

These commands give you access to software that wagitten by Weber Systems. Calculator launches
your systems default calculator. Term Window launchesra &bell.

Main Menu: Misc = NC Docs

This command will launch your system’s default webnser and display the current NC docs for the job
you are working on. The web browser will display theeuot job’s CNC output, command file, tool list,
time analysis and cost analysis.

The Settings Menu

Main Menu: Settings-> Input

These are the methods by which you place informatidhescreen. You can either enter the absolute
Cartesian value of the locations you are entering, ighgalled absolute xyz input), or you place the data by
picking the location on the screen. (This is called dynamput.)

Main Menu: Settings> Cad Settings

The purpose of the Cad Settings info packet is to setusadefault parameters in the system which were
previously hard coded into the setconstants or usercosstamts. The Cad settings packet is selected
when a New File is specified.

Main Menu: Settings 2> Defaults

This script allows system default values to be sets&lvalues are temporary for the synergy session that
you are in. When you exit Synergy and come back in the svalillego back to the defaults.

Main Menu: Settings-> Variables

Allows the value of named variables to be changed. Tvedses are temporary for the synergy session that
you are in. When you exit Synergy and come back in the svalillego back to the defaults.

Main Menu: Settings> User Views

This allows the user to capture an area of the scretoraate a view out of that. The user views can be
accessed from the graphics menu area uviigey 1, View 2, View 3, View 4, View 5.
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Main Menu: Settings-> Inverse Pens

Inverse pens are used for moving objects on the scrigeoiverasing the graphics that they pass over.
There are 5 inverse pen values 0,1,2,3,4.

Main Menu: Settings-> Storage Mode

This script will change the mode for "how to savedil You can save the entire job, just the
geometry, or just the turbopost information, (commaielahd tapefile).

Main Menu: Settings 2> View Resolution
This script will set the resolution for viewing geonyetr

Main Menu: Settings-> Plot Resolution
This script sets the resolution for plotting.

The Property Menu

Main Menu: Property - Layer

The layer options allow the user to separate padgalb by placing sections of the job under a different
number. The user can layer by an Entity, Contour, Botity Type, Workplane, or Dimension. The layers
can be shown under the Layer Control area in Synergy.

Main Menu: Property - Color

Allows the user to change the current color or changedioe of entities in a job. These can also be
accessed from the Color Control Area in Synergy.

Main Menu: Property - Line Type

Allows the user to change the current line type or chamgérte types of entities in your job. These can
also be accessed from the Line Type Control arearier8y.

Main Menu: Property - Tool
Allows the user to assign a tool to either an entiggraour or by using the box method.

Main Menu: Property = Work Zones

Allows the user to change a work zone or assign georteetryvork zone by different methods. A work
zone is a work area on a part. There are several ésampere you might use work zones: tombstone
work, parts that have many faces or sides, or fixtuset!.

Main Menu: Property - Name
Allows a name to be assigned to an entity.

Main Menu: Property - Hide
Allows you to hide or unhide different entities of your.job

The Show Menu

Main Menu: Show - All Data
Will show all geometry on the screen.
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Main Menu: Show - Color
Will show all entities of a specified color.

Main Menu: Show - Layer
Will show all entities of a specified layer.

Main Menu: Show - Line Type
Will show all entities of a specified line type.

Main Menu: Show < Group

This script allows a group that was specifically mada pkot group to be plotted. The group is
associated with specific layers and colors.

Main Menu: Show - Tool
This script allows geometry associated with a particolalrtb be plotted on the screen.

Main Menu: Show - Work Zone
This script allows geometry associated with a padicwork zone to be plotted on the screen.

Main Menu: Show - Operation
This allows a chosen operation or hole feature toltitted on the screen.

ON-OFF SWITCHES

Main Menu: Show - Hidden
This will turn on-off the plotting of hidden geometry.

Main Menu: Show - Dimensions
This will turn on-off the plotting of all dimensions.

Main Menu: Show - Area Fill
This will turn on-off the plotting of area fills that are done under Dnaft>Hatching.

Main Menu: Show - Tables
This will turn on-off the plotting of tables that are created in drafting.

Main Menu: Show - Surfaces
This will turn on-off the plotting ofthe surfaces that were created in 3D.

Main Menu: Show = 3D Cutter Paths
This will turn on-off the plotting of 3D Cutter Paths.

Main Menu: Show - 3D Cutter Path Arrows
This will turn on-off the plotting of 3D Cutter Path Arrows.

Main Menu: Show - Trim Curves
This will turn on-off the plotting of all trim curves.
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Main Menu: Show = Ruler
This will turn on-off the ruler or drawing grid. The hotkey for thisG#rl R .

The Inquire Menu

Main Menu: Inquire - Highlight

This will show what is grouped or autolinked by turning ethéng in the group blue. It will also show
arrows which indicate the direction of the autolink.

Main Menu: Inquire = Group Highlight
This is the same as Highlight but the user will cleab® name of the group to be highlighted out of a list.

Main Menu: Inquire - General (work space)
This will show the information pertaining to a pantar element relative to the current workplane.

Main Menu: Inquire - General (real space)
This will show the information pertaining to a particutde@ment relative to the standard work plane.

Main Menu: Inquire - Distance
This script measures the perpendicular distance beta@eint and an entity.

Main Menu: Inquire = Angle Two Lines
This script measures the angle between two lines.

Main Menu: Inquire - Contour

This script will interrogate a contour and bring up thlevant information in the CONTOUR
INFO BOX for viewing.

Main Menu: Inquire = Volume
This script calculates the volume, surface area, artdoigtiof a part.

Main Menu: Inquire - Part Limits
This script calculates the maximum and minimum lirofta 3D part.

Main Menu: Inquire = End Point
This script interrogates an element and will displaycth@rdinates of the end point.

Main Menu: Inquire - Pick Point

This script interrogates an element and will displaycth@rdinates of the pick point in the
PICK POINT info box for viewing.

Main Menu: Inquire - 3D Fillet Radius
This script finds the radius of a circle contained irddilet surface.
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Main Menu: Inquire - Data Size
This script will place the database information inl@ fiox for viewing.

Main Menu: Inquire - Scallop Calc
This script will calculate the Scallop height.

Main Menu: Inquire - List
This script will list the specified entities.

The Info Menu

Main Menu: Info

This is a tear off menu that will show general infation. It can also be used for stepping through the CNC
code one block at a time.

Working with the Graphics Menu

Synergy offers precision control over your viewing aréagithe menus contained in the graphics menu.

Graphics Menu: View

All of the options in the view menu are used for conitiglthe angle from which Synergy displays your
graphics. The following is a list of options:

« Top
 Bottom

e Front
 Back

* Right Side
» Left Side

e Isometric

e Isometric 2

e Isometric 3

* Isometric 4

* H (horizontal) mill view
* Lathe Iso

Rotate

This brings up th&otation Angle dialog box. Use the slider to rotate the view aboutliaey Choose the
axis of rotation by clicking on the axis described ingh@mpt line.

If you wanted to rotate the view about the Y axis:

1. Chooseriew menu View - Rotate. The prompt line will reaMOVE SLIDER Xaxis,
Yaxis, Zaxis, Turn90, Reverse?

2. Click Yaxis in the prompt line.

3. Slide theotation Angle slider.

4. When you are satisfied, Click thgit button.

Exit
You must manually exit the Rotation Angle Dialog box wheun gre rotating your views.
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Axis
The axis button lets you pick the line you want Syneogyse as a reference for the rotation. Synergy will
not rotate about a point or circle you must pick a line.

Zero
The zero button sets the rotation angle for the asirsglrotated about to zero.

Refresh
Fit
Fit automatically scales the your geometry to make isaqgpears in the graphics window.

Redraw

The redraw button will recreate the geometry in th@hjes window. Use this feature to clean up artifacts
that might appear on your screen without resizing your view.

Refine

Use refine when you want to ensure that your screenepia an accurate representation of what is
really being created. This is especially useful when yewansiderably zoomed in on your geometry.

Resize All
If you are working with multiple graphics windows, resalewill perform fit across all of them.

Refine All
If you are working with multiple graphics windows, refialéwill perform refine across all of them.

View On andView Off

Once you have created drawing views in your geometrycgouurn those views on or off by using these
commands.

Zoom

Zooming is self-explanatory. Zooming in on your geometigied you to view the fine details of your
geometry up close. Zooming back lets you view all youngdny from a distance to get an overall view of
the part.

Synergy offers several methods of zooming.

Graphics Menu: Zoom - Two pt. Zoom <f3>

Two point zoom lets you zoom in on your geometry usidgreamic zoom box. The dynamic zoom box
grows and shrinks from its center.

Graphics Menu: Zoom = Previous <f4> and Graphics Menu: Zoom> Next <f5>

Zoom Previous and Zoom next let you switch back and foattlvden previous zooms. Each time you
zoom, Synergy remembers where and what you zoomed. 2aoaxt and zoom> previous let you
quickly flip back and forth between zooms.

Graphics Menu: Zoom - half <f11> and Graphics Menu: Zoom-> Double <alt> + <f11>
Zoom-> half automatically reduces the scaling factor by.té&om=> half zooms back.

Zoom-> double automatically increases the scaling factor by awm->double zooms in.
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Graphics Menu: Zoom - Unzoom

Unzoom resets the graphics window to the last fitqperéd. It is the same as clickiRRgfresh> fit,
except that Synergy will not check to make sure thahalgeometry is contained in the graphics window.

Graphics Menu: Zoom - Pan <f6>
Panning lets you move the view around in the graphingaw.

Render

Synergy’s rendering abilities have been enhanced withdidlié@n of Open GL manipulation and viewing
techniques. On the surface, these changes are transphegntising Synergy's View: Render menu
commands, however, OpenGL makes working with and visual&irfgce and wireframe geometry
considerably easier.

View: Render > Refresh
Puts Synergy into an OpenGL mode where you can work withgemometry as shaded surfaces.

View: Render - Refresh / Wire

Puts Synergy into an OpenGL mode where you can work withgemmetry as shaded surfaces and
visible wire frames.

View: Render > Wireframe
Puts Synergy into an Open GL mode where you can work withgenmetry as OpenGL wire frames.

View: Render - Rotate

Use this command to put Synergy into a Viewing Mode gftarhave rendered your geometry. The
viewing mode is for rotating, zooming and rendering geonanly. You will not be able to create or make
changes to geometry when you are in the viewing modes Resg> to leave the viewing mode.

While in the viewing mode, use your mouse to manipulate thegiey:

» Left Click and hold while you drag your mouse to tilt yg@ometry
* Middle Click to Pan your geometry
* Right Click to zoom your geometry

Panning and Zooming are mode based, and will requirenaah@left) click to exit from panning or
zooming mode. Tilting is not mode based, and thereitirey does not require a second click to exit from
tilting mode. Simply click and hold the mouse button whil@gging to tilt your geometry.

View: Render - Render Off
Turns off Synergy’s OpenGL functions.

View: Render - Remove Triangles

This is a command that is used to remove superfluous regdeformation from your computer’s
memory.
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Drawings

View: Drawings = On and View: Drawings> Off
This is a toggle menu for turning the display of drawingswd off.

What are drawings?

Synergy Drawings are methods of displaying data in the &randrafting drawing without creating
separate geometry for each view. Drawings are onlyiéwing. It is not possible to work with the
geometry represented by a drawing.

You will need to specify the length and width of the dregvThe lower left corner of the drawing is
always placed at zero. A negative length or width maydoessary for drawings imported from IGES.

Once you have specified the drawing’s length and widith egw is placed and clipped on the drawing
relative to the lower left corner.

Once specified, the drawings may be deleted, moved, anddotahe clip points and views may be
changed.

To plot a drawing to scale, the length and width ofdteeving must match the physical dimensions
available on the plotter.

Synergy’s drawings differ from IGES drawings.

User Views

The remaining buttons on the Graphics Menu are threvissgs. These buttons are marked View 1, View
2, View 3...

They are used to quickly switch between predefined cusimmsettings.
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Input Options

Absolute (XYZ) Input

Synergy has two main ways of asking you where you waplatze information on the screen. You either
enter the absolute Cartesian value of the locationsay® entering, (this is call absolute (xyz) input), or
you place the data by picking the location on the scréenigtcalled dynamic input).

Which method of input you use is controlled using the icpatrols located on synergy’s main interface.
(See: Introduction to the Interface.)

XYZ INPUT OPTIONS

Rectangular [R]
This option creates a point at the X,Y,Z coordinatesster.

You have three more options when in rectangular mode, whicltan also control using the input
controls.

Center return
A point is created at the coordinates of the arc cente

Midpoint return
A point is created at the coordinates of the midpoirat lofe.

End point return
A point is created at the end point nearest the point picked.

Free Point [f]
This option creates a point at the present cursoritocat

Intersect M
This option creates a point at the intersection ofdlements.

Nearest [N]
This option will create a point nearest to the cutgothe entity.

Polar [p]
This option creates points that are defined in polar coatel (radius and angle).

Spherical [s]
This option creates a point that lies on a spheresadefined by a radius and two angles.

X & Angle [xa]

This option creates a point at an absolute X locatiohaanangle. The angle is referenced from the last
point

Y & Angle [ya]

This option creates a point at an absolute Y locatiohsanangle. The angle is referenced from the last
point.
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X & Hypotenuse [xh]

This option creates a point at a known X coordinate sspkeified distance from the last point described.
If the specified distance does not intersect the Xdinate, no point is created.

Y & Hypotenuse[yh]

This option creates a point at a known Y coordinate sspmkeified distance from the last point described
NOTE: If the specified distance does not intersecivticeordinate, no point is created

Hypotenuse: Angle [ha]
This option creates a point at a specified distance raglé &om the last point described.

X & Entity [xe]
This option creates a point on an entity at a knownction.

Y & Entity [ye]
This option creates a point on an entity at a knownc#tion.

Angle: Element: [a€e]
This option creates a point at a specified angle inténgean entity.

Lathe Point [Ip]
This option creates a point using Z-axis and diameters.

Selecting Input Options Automatically

Position the active point with your cursor. Clickintpeation on the viewing window selects a point
according to the following rules:

1. If the cursor is within the pick distance of an existintity it will pick the entity in the same
method as an ordinary XYZ input.

2. If no entity is within pick distance it will selecffr@e point. The free point is always on your
existing work plane and has a Z coordinate in the work gaero.

3. If your cursor is on a ruler, the program will selde closest ruler point.

Be careful not to place the cursor close to an eggintity, because the program will select the entithe(
#1) before it selects a free point (rule #2.)

Absolute Input Keyboard Shortcuts
To manually select the active point, use the following keys

Enters normal XYZ input. All normal functions aetive.
Enters Nearest Mode.

Enters Intersect Mode.

Enters Lathe Input Mode.

Exits the dynamic mode and leaves script.

Backup. Destination determined by the script.
Restart script. Goes to beginning of script.

xXmmr—2Z27210

Synergy Training 23 Weber Systems, Inc.



Synergy Mill

Dynamic Input

Dynamic input allows the entity to change in referendahéolocation of the cursor.

While most commands require only one point to defineetitdy, some commands require two points. For

example, commands that require picking two points incliigi®e Two points, Circle Rad Two Points,
Axis Cylinder and Line Plane.

Dynamic Input Keyboard Shortcuts

Not all of these keys are active for all entitiest Example, some entities, (like torus) may have degrfees

freedom not addressed by these keys. Some entitiasowilise some of the keys. (There is no reason to
adjust the radius of a rectangle.)

You can experiment with the keys to determine what keysetive on which occasions:

[+/-]
[6]
[4]
[8]
[2]
9]
[7]
3]
[1]
[>]
[<]
[1]
[[]
/]
[*:]

changes the sign of an angle.
increases the starting angle.
decreases the starting angle.
increases the angular extent.
decreases the angular extent.
increases the a second angle.
decreases the a second angle.
increases the a third angle.
decreases the a third angle.
increases the radius/length.
decreases the radius/length.
increases the second radius/length.

decreases the second radius/length.

increases the third radius/length.
decreases the third radius/length.
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Exercise 1: Circles and holes with Dimensions

4.000

3.250

2.750

2.0600

R 1.00

000 ¢ ples

2 ples

jSA

/f — P 281 dra. 4 ples
— ~ \/

\.38 x 45 deg. chamfer

2 plcs

.daa

. 500

1.500 3.0d0 4.500 5.250 5.4dda

5.500

Construct Outside Contour

Start a new file
Click on File=>New

START NEW JOB FILE Yes or No? REP=Y
With the left mouse button click on the words

CAD SETTINGS FILE NAME?
Choose thelefault_in cad settings file.

Change Graphical Mode

From the main menu, chooSettings> Variables. Highlight Graphical mode=Onthen press OK. This
will change the setting for the graphical mode to off.

GraphicalMode=0ff

Choose cancel to close the select box.

This will turn off Synergy’s Dynamic mode, which makbegde exercises less complicated for the beginner
user. Hit Cancel to close the named variables menu.

Synergy Training
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Place a point on the screen

Click Points=>Input XY, directly under Construct, located on the tab meFhe Prompt line will ask you
where you want your point located. Enter 3 in the Inmat for ABS X, hit enter, Enter 2 in the Input line
for ABS 'Y, hit enter.

The questions for ABS X and ABS Y will keep repeating.get out of this loop you can either choose a
new menu pick or chooddisc > Leave Script

Click on A in the main menu. Then click @esign: Construct -> Lines - Point Angle
ANGLE: 0

LI NE LOCATI ON ABS X? 0

LI NE LOCATI ON ABS Y? 0

LI NE LOCATI ON ABS 7?0

ANGLE: 90

LI NE LOCATI ON ABS X? 0

LI NE LOCATI ON ABS Y? 0

LI NE LOCATI ON ABS 7?0

You can choose M SC-> Leave Scri pt to getout of the Line questions or
by choosing another menu pick the questions will go away.

Construct line parallel at specified parallel distance

Design (you're already there): Construct - Lines - Parallel
PARALLEL DI STANCE: 4

Pl CK PARALLEL LI NE?
Pick the horizontal line, then pick above the horizbiria

Input New distance:
PARALLEL DI STANCE: 6

Pick the vertical line, then pick on the right sidehaf vertical line

Construct circle defined by radius and center

Desi gn: Construct - Circles 2 Rad: Center
Cl RCLE RADI US: 1.75

Cl RCLE CENTER ABS X: 3,-.750,0

Cl RCLE RADI US: 1

Cl RCLE CENTER ABS X: 3,1.5,0

Split element

Desi gn: Construct - Trim-> Split
PICK ELEMENT TO BE SPLIT?
a. Select the lower horizontal line as the elemebetsplit

SPLIT POINT: PICK NEAREST ELEMENT?

b. Pick the split point on the line near the middl¢hef1.75 radius circle.
PICK ELEMENT TO BE SPLIT?

c. Select the 1.75 radius circle as the element to he spl

SPLIT POINT: PICK NEAREST ELEMENT?

d. Pick its split point at the top of the circle at 90 degr
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(4) Fourth Pick \

(1) First chk\ | (2) Second Pick Point

(3) Third Pick —

Construct corner fillet
Design: Construct-> Trim - Fillet

FI LLET RADI US : .5

Pl CK ELEMENT TO BE TRI MVED, None, Single, Radius
Note: When putting in fillets, always pick the portion of the geometry you want to save
Pick the left side of the lower horizontal line.

PICK SECOND ELEMENT

Pick the left side of the 1.75 rad. Above the lower tomial line.
PICK ELEMENT TO BE TRIMMED, None, Single, Radius

Pick the left side of the 1.75 rad.

PICK SECOND ELEMENT

Pick the lower left side of the 1.0 rad.

PICK ELEMENT TO BE TRIMMED, None, Single, Radius

Pick the right side of the 1.75 rad above the lower bot# line.
PICK SECOND ELEMENT

Pick the lower right side of the 1.0 rad.

PICK ELEMENT TO BE TRIMMED, None, Single, Radius

Pick the right side of the lower horizontal line.

PICK SECOND ELEMENT

Pick the right side of the 1.75 rad.
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PICK ELEMENT TO BE TRIMMED, None, Single, Radius
(dick on the word Radi us)

FILLET RADIUS : 1.0

PICK ELEMENT TO BE TRIMMED, None, Single, Radiu s

Pick the left side vertical line below the upper horiabfihe.

PICK SECOND ELEMENT

Pick the upper horizontal line making sure to pick thei@onf the elements you want to save.
PICK ELEMENT TO BE TRIMMED, None, Single, Radius

Pick the right side vertical line below the upper horiabtie.

PICK SECOND ELEMENT

Pick the upper horizontal line.
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(2) Second Pick \

(4) Fourth Pick
/

(1) First Pick ——>

< (3) Third Pick

/

Construct corner chamfer

Design: Construct-> Trim - Chamfer
CHAMFER LENGTH: .38

PICK ELEMENT TO BE TRIMMED, None, Single, Radius
Pick the left side of the lower horizontal line (n#ze 1.75 rad.)
PICK SECOND ELEMENT

Pick the left side vertical line.

PICK ELEMENT TO BE TRIMMED, None, Single, Radius
Pick the right side of the lower horizontal line (nte 1.75 rad.)

\
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PICK SECOND ELEMENT

Pick the right side vertical line.

(2) Second Prck — ' =—(4) Fourth Pick

(1) First Pick— ~(3) Third Pick
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Choose Refresh>Fit

N

Construct Inside Contour

Construct circle defined by radius and center

Design: Construct-> Circles 2 Rad: Center
Cl RCLE RADI US: 1

Cl RCLE CENTER 4.5,2,0

Cl RCLE RADI US: 1

Cl RCLE CENTER 1.5,2,0

Construct line parallel at specified parallel distance

Desi gn: Construct - Lines - Parallel
PARALLEL DI STANCE: 1.25
Pick a section of the lower horizontal line, then pickhe area above that line.

PARALLEL DI STANCE: 2.75
Pick a section of the lower horizontal line, then pickhe area above that line.

Trim two intersecting elements

Trim (to sharp edges) the inside intersections ofittes lwith the 2.0 DIA. circles.
Desi gn: Construct - Trim > Corner

PICK FIRST ELEMENT TO BE TRIMMED?
Click on the top line between the 2 circles.
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PICK NEXT ELEMENT TO BE TRIMMED?
Click the left side circle above the top line.

PICK FIRST ELEMENT TO BE TRIMMED?
Pick on the top line between the 2 circles.

PICK FIRST ELEMENT TO BE TRIMMED?
Click the right side circle above the top line.
PICK FIRST ELEMENT TO BE TRIMMED?
Pick the lower line between the 2 circles.

PICK NEXT ELEMENT TO BE TRIMMED?
Pick the left side circle below the lower line.
PICK FIRST ELEMENT TO BE TRIMMED?
Pick the lower line between the 2 circles.

PICK NEXT ELEMENT TO BE TRIMMED?

Pick the right side circle below the lower line.

N
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Place Circles

Place hole locations by creating Circles

DESIGN-> Construct - Circles > Rad: Center
CIRCLE RADIUS: .281/2
Place the circles at the following locations:

Circle one:

CIRCLE CENTER ABS X: .5
CIRCLE CENTER ABS Y: .5
CIRCLE CENTERABS Z: O

Circle two:

CIRCLE RADIUS : Hit the repeat button. (Middle mouse button)

CIRCLE CENTER ABS X: .75
CIRCLE CENTER ABS Y: 3.25
CIRCLE CENTERABS Z: O

Circle three:

CIRCLE RADIUS : Hit the repeat mouse button.
CIRCLE CENTER ABS X: 5.25

CIRCLE CENTER ABS Y: 3.25

CIRCLE CENTERABS Z: 0

Circle four:

CIRCLE RADIUS : Hit the repeat mouse button.
CIRCLE CENTER ABS X: 5.5

CIRCLE CENTER ABS Y: .5

CIRCLE CENTERABS Z: 0

O
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AUTO LINKING

Autolinking lets you join independent geometry together. Ankotg also tests to see that this geometry is
properly connected for machining. Create a piece of 2D gegnand then use Autolinking to quickly
create a contour.

Create the contour
ChooseDESIGN (you're already there}y> Construct 2 Group 2 Autolink <Ctrl-A>

Pl CK START ELEMENT, Single?

The system is asking you to indicate where your contaurldtstart. Pick anywhere on the outside
contour. The prompt line will then read:

Pl CK END ELEMENT?

Your next click will tell Synergy where you want the taur to end. Pick the same location. You will
notice that Synergy placed directional arrows on atho$é entities. This ensures that all entities,
regardless of how they were created, are all trav@hitige same direction.

The Prompt line now reads:

PICK NEXT, Backup, Single, New?

You want to stop, move the tool, and start an entatéfgrent contour so you need to click with the left
mouse button on the woldew. Autolink the inside contour by clicking the same locativice.

Misc - Leave Script

Now chooseMain Menu: Inquire - Highlight. Pick the outside contour. This will show the whole
contour has been highlighted. Use lihguire = Highlight on each contour to verify it is Autolinked.
You must choose thiaquire - Highlight for each contour because it only allows you to pick are a
time.

Name the Contour

Give the outside contour a name
DESIGN: Construct = Group—> Name

PICK THE CONTOUR TO BE NAMED:
Click on the outside contour.

CONTOUR NAME:
Give the contour a name by typing in the input promptll tia outside contouioutside_contour.

Give the inside contour a name

PICK THE CONTOUR TO BE NAMED:
Click on the inside contour.

CONTOUR NAME:
Give the contour a name by typing in the input promptll tBainside contourinside_contour.

ChooseMain Menu: Inquire - Contour and pick the contour to see the contour information which
includes the names.

Synergy Training 34 Weber Systems, Inc.



Synergy Mill

Create a Group — later this group will be used to applyoles by a single key stroke.

Group the circles by common diameters
DESIGN: Construct = Group - Create-> Circle Diameter

Di ameter to G oup By?

Click on any of the .281 circles you just created

Layer Number, current layer=07?

Click on any .281 circles you just created.

This question is asking you to indicate what layer thelas are on now. By left clicking on one of the
circles, the system will grab the layer number thatdircles are currently on.

Group Name?
Name the group: 281 _holes

Color to Assign Group?
Pick the color that the group will be — you must enteamber for the color. Refer to the color contrds.
is black, 1 is white, 2 is red, etc.

Layer to Assign Group?
This is the layer that the Group will appear on. Type 1.

You can assign layers and colors specific to the grotipsapoint. If you click the REP key, Synergy will
accept the defaults.

You will notice that all the circles of that diametaerned the color that you assigned the group. Grouping
of circle diameters can be very useful when working bahat came through in IGES with many circles
that need operations applied to them.

Archive your job

It's time to save the geometry that you've createdi ¥an do this by using Synergy’'s Archive feature. The
file archive is designed to store the Synergy file glaiith all associated file components into a directory
structure.

From the Main Menu, choo$éle = Archive = Save-> Archive

The following instructions are for creating a new projet directory from scratch:
The prompt line box will ask:

SELECT PROJECT New directory, List?

This prompt means that you have to tell Synergy wheanenamt to archive your file. Because this part has
never been archived before, you are going to creates ainectory.
Click the wordNew in the prompt line. The prompt will ask you to natne nhew directory:

NEW PROJECT DIRECTORY NAME?

Enter:Training.d

Fill out the Multi-entry dialog box. You can name this gfything you want to in the name box (but avoid
numeric expressions). Enter a description. Enter youen&mter a status. Then click & button.

The system has placed you (although it doesn’t show yitneabp yet), in the
/usr/weber/archive/training.d directory.
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SELECT PROJECT New directory, List?

This question is now asking for the project name.
Name the project Exercisel by typing into the input lihen press <Enter>.

Fill out the next multi-entry dialog. Enter the followingaa

Project name: Exercisel
Description: (Describe the part)
Author: (Put your name here)
Status: In Progress

When you have finished, click OK.

Now that the part has been archived, you can always kesspafrthat directory the part is stored in
because the directory path will be displayed on Synetigigdar.

Now chooseMain Menu: File - Archive - List 2 Archive List and find your new project in the list.

Review: Drawing Exercise 1

Here are the five steps that you used while creategd&ometry in exercise one.

You drew the geometry using synergy's geometry construtgtchniques.
You placed circles to indicate where your holes aregdoitoe.

You created a group of circles to use later for fealtures.

You autolinked the geometry to create contours fdimgi

You've named the contours.

S T o o

You've archived your work.
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Manufacturing:

Exercise 1: Circles and Holes

Hole Features

Hole features are a way to place a hole or group eshlat contain all the relevant manufacturing data in
a single instance.

Place hole features for the .281 group
Click A on main menu, then choose Variational:VMill = Holes=> Dirills

VARIATIONAL OBJECT NAME?
Type in Exercise.mfg.

FEATURE FILE NAME?

Click on twistdr.2812 and hit enter.

Drill depth?

Hit the middle mouse button to except the REP value of 1.0

Hole type ( 0 )BLIND or ( 1 )THRU?

Type 1 <enter> for THRU.

PICK HOLE CENTER POINT, Group, New?

Click with the left mouse button on the wdBdoup.

PICK GROUP, Point, New? REP=P

With the left mouse button, click on one of the cisdleat you previously grouped.

You will notice that Synergy placed the drilling holatigre on all four of the holes with one pick. This
hole feature consists of a .5000 Spot drill and a .281&tdl. The hole features are totally user
configurable to way your company manufactures.

Place hole features for the second group.
ChoosevMill - Holes-> Dowels

FEATURE FILE NAME?

Choose the dowel.250 hole feature and click OK.

Drill depth?

Type .5 and hit <enter>

Ream depth?

Type .25 and hit enter.

Hole type ( 0 )BLIND or ( 1 )THRU?

Type 0 and hit <Enter>

PICK HOLE CENTER POINT, Group, New?

With the left mouse button click on the point in the eeiof the part.
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N

Generate Cutter Paths

Machining the inside and outside contours
ChooseVmill - Path > Finish Mill

INPUT TYPE OF TOOL?

Choose endmills

INPUT TOOL FILE NAME?

Choose endmill_0.65

TOOL NAME, Default?

Click on the word Default with the left mouse button.
INPUT HOLDER TYPE, None?

Choose the bt40.inch.

MILL Climb OR Conventional :

Click with the middle mouse button to except CL.

FINISH ALLOWANCE :
Type .02 and then hit enter.

PICK AN ELEMENT OF CONTOUR TO BE OFFSET:
Pick an element of the outside contour, then pick in tha awtside of that contour to determine which side
will be machined.
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FINISH DEPTH: .5

Pick an element of the inside contour, then pick in tka aside of that contour to determine which side
will be machined.

FINISH DEPTH : .5
Vmill = Path = Finish Mill

This will pop up a selections box where you will selbet éndmill that you selected in step 2.
Choose .65 Endmill.

MILL Climb or Conventional: CL
FINISH ALLOWANCE: 0
PICK AN ELEMENT OF CONTOUR TO BE OFFSET?:

Pick an element of the outside contour, then pick in tha awtside of that contour to determine which side
will be machined.

FINISH DEPTH: .5

f

N TN\

Remove Duplicate tools
Variational: VMill - Tools > Remove Duplicate Tools

When holefeatures are used the tools are loaded forhede that you put in. When running the turbopost
manually (Not using AMO), you must remove the duplicatéstooyou will have duplicate tools in the
tool section box when posting the job.
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Turbopost the Job

TURBO POST setup consists of a series of ASCII filagch configure the NC output, define user
variables, user commands, templates and macros; and defstion sequences. Posting the job will create
CNC tapecode, time calculations, tooling lists and aawslysis.

To TurboPost the job, choo%ariational: Vmill - Execute-> Turbopost

From the selections box, choose the “globalhmill.”efiselect “New” from the command file types
presented in the selections box.

The Prompt line will tell you to select the post comiha
Enter these Turbopost commands:

STARTUP:

ENTER THE PROGRAM DESCRIPTION: Exercise 1
ENTER THE PROGRAM NUMBER: 1

ENTER THE TOOL NUMBER: 1

ENTER THE NEXT TOOL NUMBER: 2

ENTER THE INITIAL Z VALUE: 1.0

Choose the .500 Endmill from the selections box afir$teool.

SPINDLE SPEED: 1175
CUT_CONTOUR:
PICK PATH, Proceed?

Pick all three of the cutterpaths in the order that yoatw@amachine them. Then chogeeceed

TOOLCH:
ENTER THE NEXT TOOL NUMBER: 3
ENTER THE INITIAL Z VALUE: 1.0

Choose the .5 spotdrill as the next tool.

SPINDLE SPEED: 1175

FEED RATE: 2.35

DRILL:

PICK HOLE, Sequential, Group, Manual, Proceed?

Pick the five center dilled holes. Then chopsaceed

TOOLCH:
ENTER THE NEXT TOOL NUMBER: 4
ENTER THE INITIAL Z VALUE: 1.0

Choose the .2812 Twist Dirill.

SPINDLE SPEED: 1175

FEED RATE: 2.35

PECK_DRILL:

PECK DISTANCE: .1

PICK HOLE, Sequential, Group, Manual, Proceed?
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Pick the four twist drilled holes. Then chogseceed

TOOLCH:
ENTER THE NEXT TOOL NUMBER: 5
ENTER THE INITIAL Z VALUE: 1.0

Choose the .2187 twist drill.

SPINDLE SPEED: 1175

FEED RATE: 2.35

PECK_DRILL:

PECK DISTANCE: .1

PICK HOLE, Sequential, Group, Manual, Proceed?

Choose the single twist drilled hole. Then chquseeed

TOOLCH
ENTER THE NEXT TOOL NUMBER: 6
ENTER THE INITIAL Z VALUE: 1.0

Choose the .2500 reamer.

SPINDLE SPEED: 1175
FEED RATE: 2.35
DRILL:

Pick the single reamed hole. Then chquseeed

END_CODES:

CANCEL.

SELECT POST FUNCTION : EXECUTE COMMAND FILE
SELECT POST FUNCTION : CANCEL

Load tool images:
Variational: VMill - Images > Make all Mill

Show Documentation
Main Menu: Misc> NC Docs

The NC docs will show you a Time analysis, Toolirgl), ICost analysis and the NC code.

Archive
Main Menu: File> Archive > Save—~> Archive

REVISION 2 NOTE: None:

Type added manufacturing.
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Exercise 2: Advanced 2D

37.9° typ

\/ .29-20 unc b ples

R .200
typ

R 500 —

‘\J
CJ?
mo
1

o

Synergy Training 42 Weber Systems, Inc.



Synergy Mill

Construct Outside Geometry

Begin a new file

Main Menu: File - New
Choose the Default CAD SETTINGS

Draw axis lines
Design: Construct - Lines - >Axis Lines

Construct circle defined by radius and center

Design: Operations - Circles - Rad: Center
CIRCLE RADIUS : 1.466
INPUT ABS X : 0
INPUT ABSY: 0
INPUTABS Z:0
CIRCLE RADIUS : .896
INPUT ABS X : 0
INPUT ABS Y :-1.41
INPUT ABS Z:0
CIRCLE RADIUS : .25
INPUT ABS X : -2.2
INPUT ABS Y : -1.87
INPUTABS Z:0
CIRCLE RADIUS : .19
INPUT ABS X : -1.91
INPUT ABS Y : .88
INPUTABS Z:0
CIRCLE RADIUS : .19
INPUT ABS X : 0
INPUT ABS Y : 1.625
INPUTABS Z:0

Tangent line trim

Design: Construct - Trim - Tangent Line
PICK FIRST TANGENT ELEMENT:

Pick on the lower right side of the 1.466 rad.

PICK NEXT TANGENT ELEMENT:
Pick on the lower right side of the .896 rad.

Tangent circle trim

Design: Construct - Trim > Tangent Circle
TANGENT CIRCLE RADIUS : .5

PICK FIRST TANGENT ELEMENT:

Pick the upper left side of the 1.466 rad.

PICK NEXT TANGENT ELEMENT:
Pick on the upper right side of the left hand .19 rad.

Construct line tangent to element at angle

Design: Construct - Lines - Tangent Lines
PICK TANGENT ELEMENT:
Pick on the bottom of the .25 rad.

ANGLE OF TANGENT LINE: O
PICK TANGENT ELEMENT:

- Known Angle: Tangent
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Pick on the left side of the .25 rad.

ANGLE OF TANGENT LINE : 100
PICK TANGENT ELEMENT:
Pick on the upper left side of the left hand .19 rad.

ANGLE OF TANGENT LINE : 45
PICK TANGENT ELEMENT:
Pick on the upper left side of the right hand .19 rad.

ANGLE OF TANGENT LINE : 90-37.5
PICK TANGENT ELEMENT:
Pick on the upper right side of the right hand .19 rad.

ANGLE OF TANGENT LINE : 90+37.5

Construct corner fillet

Design: Construct = Trim - Fillet

FILLET RADIUS : .2

Place the fillet on the left side between the bothmrizontal line and the .896 rad.

PICK THE ELEMENT TO BE TRIMMED : Radius
FILLET RADIUS : .25
Place the fillet between the 10 degree and the 45 degyksidimes.

Trim two intersecting elements

DESIGN: Construct - Trim - Corner

Corner trim both sides of the bottom left .25 radefMeorner trim the three remaining untrimmed lines to
their respective .19 radii.

2D rotate multiple elements

DESIGN: Rims - Rotate - Multiple Elements - 2D Duplicate
PICK ELEMENTS TO BE ROTATED:
Pick the top .19 rad. and the two remaining untrimmedline

PICK ELEMENTS TO BE ROTATED, Backup , Proceed : P
REFERENCE POINT ABS X : 0

REFERENCE POINT ABS Y : 0

ROTATION ANGLE : -60

NUMBER OF TIMES : 1

2D invert multiple elements

Design: Rims - Invert - Multiple Elements - 2D Duplicate
PICK ELEMENTS TO BE INVERTED:
Pick the top .19 rad. and the two untrimmed lines sarpesaus step.

PICK ELEMENTS TO BE INVERTED, Backup , Proceed : P
REFERENCE POINT ABS X : 0

REFERENCE POINT ABS Y : 1.625-(2.34+1.625)/2
INVERSION ANGLE : 0

Split element
Desi gn: Construct - Trim > Split

Split the 1.466 rad. in two places in line with the .19ir@adB0 degrees and 90 degrees, then split the .896
rad. in line with the .19 rad. at 270 degrees.
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Construct corner fillet

Design: Construct = Trim - Fillet

FILLET RADIUS : .2

Fillet the remaining untrimmed lines to the 1.466 and ragé.

Construct large pocket

Change Layer

Create Layer 1 by middle mouse clicking in the white phtihe layer area that says 0. You will know if
you have created a new layer when it appears in yee ¢t@ntrols. Your current layer will be highlighted.
You can also check to see what layer you are on by chiettkéninfo menu from the main menu.

Construct circle defined by radius and center

Design: Construct - Circles - Rad: Center
CIRCLE RADIUS : 1.34

INPUT ABS X : 0

INPUT ABS Y : 0

INPUTABS Z:0

CIRCLE RADIUS : .77

INPUT ABS X : 0

INPUT ABS Y :-1.41

INPUTABS Z:0

Construct line tangent to two entities

Design: Construct - Lines - Tangent Lines - Two Tangents
PICK FIRST TANGENT ELEMENT:
Pick the left side of the .77 rad.

PICK NEXT TANGENT ELEMENT:
Pick as far as you can to the right side of the .Joatside contour) so that the system will locate an
implied tangency point.

Construct corner fillet

Design: Construct -2 Trim - Fillet
FILLET RADIUS : .25
Place the fillet between the new line and at the fapeothe 1.34 rad.

Tangent line trim

Design: Construct - Trim - Tangent Line
Place the tangent line between the 1.34 and .77 rathieanght side.

Trim element

DESIGN> Construct - Trim - Element
Trim the .77 rad. to the line on the left side.

Construct small pocket

Change Layer

Middle click the f] button on the Layer controls on the interface. Thearemhew layer number in the
pop-up dialog box. In this case, create layer 2. You wilikkiioyou have created a new layer when it
appears in the layer controls.
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Construct line parallel at specified perpendicular dstance

Design: Construct - Lines - Parallel
PARALLEL DISTANCE : .25
1. Pick the large pocket left side line, then pick toldfteof that line.

PARALLEL DISTANCE : .25
2. Pick the 45 degree line (outside contour), then pithdanside of the outer contour.

PARALLEL DISTANCE : .25
3. Pick the 100 degree line (outside contour), then pidketaside of the outer contour.

Construct line at specified angle and distance from at

Design: Construct - Lines - 2D Lines - Point: Dist: Angle
Pick the .77 rad. on the large pocket.

PERPENDICULAR DISTANCE : .625
ANGLE OF LINE : -10

PICK LEFT/RIGHT OF LINE:

Pick in the area below the newly created line.

Pick the .77 rad. on the large pocket.

PERPENDICULAR DISTANCE : 2
ANGLE OF LINE : 80
Pick in the area to the left of the newly created.line

Construct a line parallel at a perpendicular distance

Design: Construct - Lines - Parallel
PARALLEL DISTANCE : 1.05
Pick the bottom -10 degree line, then pick in the areaathat line.

Construct concentric circle

Design: - Construct - Circles - Additional Methods >

Offset Circle

PARALLEL DISTANCE : .25

Pick the .5 rad. on the outside contour, and then picleiattba outside of the .5 rad (inside of the outer
contour).

Construct corner fillet

Design: Construct -2 Trim - Fillet
FILLET RADIUS : .25
Fillet trim all the elements to complete the smallksbc

Place Circle Geometry

Change your current layer

On the layer controls, click on the number that yontwa make your current layer. Change back to layer
zero. You can check your current layer on the info menu.

Select a new line type

From the property controls, click the line type memgéet a pop up menu for picking a new line type.
Select the dotted line, line type 2.
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Construct circle tangent to three elements

Design: Construct - Circles - Three Tangents
Pick the 100 degree line on the outside contour, thertltiee twvo tangent lines of the small pocket to place
the hidden line circle.

Reset Original line type
Use the line type menu to return to your original ligge. (Line type 1)

Construct line parallel at specified perpendicular dstance

Design: Construct - Lines - Parallel
PARALLEL DISTANCE : .125
Pick the line on the left side of the large pocket, thiek to the left of that line.

Design: - Points - Additional Points - Element and Y value
INPUT ABS Y: -1.87

PICK INTERSECTING ELEMENT:

Pick anywhere on the parallel line that you just created

Autolink Contours

Be sure that the untrimmed line has been deleted. THievalire that the Autolink feature works
correctly.

Autolink around the outside geometry
Design: Mill - Path - Autolink
Pick anywhere on the outside geometry, and then pick &gaidicate the contour’s direction.

PICK NEXT , Backup, Single, New : N

Autolink around the large pocket.
Pick “New” from the prompt line, then pick anywhere oa Brge pocket. Pick again to indicate the
contour’s direction.

PICK NEXT , Backup, Single, New : N

Autolink around the small pocket.
Pick “New” from the prompt line.

Pick anywhere on the small pocket, and then pick agandicate the contour’s direction. Name this
contour: “inside_right”

Name the Autolinked Contours

RIMS - Group -> Name
Name the 3 contours you just created.

Crosshatching

Hatch the area inside exterior contour and outside irdrior islands

Design: Drafting - Hatching - Crosshatch
PICK EXTERIOR CONTOUR:
Pick the outside contour.

NUMBER OF ISLANDS : 2
PICK ISLAND #1.:
Pick one of the pockets.
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PICK ISLAND #2:
Pick the other pocket.

Dimensioning

Assign a new current layer
Create and switch to layer 5.

Create dimensions using reference point

Design: Drafting - Datum - Auto

DIMENSION ANGLE : 90

DATUM ABS X : 0

DATUMABS Y :0

DIM LOCATION: PICK FREE POINT:

Pick to the left side of the part where you want theedisions located.

PICK FIRST CORNER OF PICK ZONE:
Pick opposing corners of a box that will include the erart.

Construct linear vertical dimension

Design: Drafting - Standard - Vertical - Single
VERTICAL DIM START ABS X:
Pick the circle located at X0 YO.

VERTICAL DIM END ABS X:
Pick the .19 rad at 30 degrees.

DIM LOCATION: PICK FREE POINT:
Pick to the right where you would like to place the disiemn.

Change text orientation in a dimension.

Design: - DrftCitrl - Modify > Text - Orient

PICK DIMENSION:

Pick the .8125 dimension previously created. (When you eképitext, be certain to pick the upper left
corner of the text.)

Construct radius dimension

Design: - Drafting —> Circular - Radius
PICK CIRCLE:
Pick on the right side of the 1.466 rad., then placeliinension.

Construct line of text

Design: - Drafting > Text > Draw - Text
INPUT TEXT LINE : Enter some meaningful text

Using FREE POINT mode pick a point to the lower righthef part.
INPUT ABS X: F

Archive the job

Refer to the archive method described on page 35.
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Exercise 2: Advanced 2D
Manufacturing

Holes

Create tapped hole operation

Variational: VMill - Holes - Taps
Locate the tap.250-20NC and click <OK>.

DRILL DEPTH : 1

TAP DEPTH : .75

GROUP, Single, New : S

Individually place five of the .25-20 holes by picking theiirad the outside contour. (You must cho&se
between each hole.)

Create socket head cap screw operation

Variational: VMill - Holes > Cap Screws
Locate the feature: capscrew.375 and click <OK>

DRILL DEPTH : 0.5
GROUP, Single, New : S
Pick the hidden line circle to place the hole.

Load Tool

Load tools from tool library

Variational: VMill - Tools - Read Tool
Select a material, and select “endmills.” Find &adl the .500 endmill. Accept the default toolname.
Click Cancel twice to leave the read a tool selestioox.

Pocket Milling

Create a new layer
Create and switch to layer 10.

Follow pocket with full look ahead

Variational: - VMill - Rough - Pocket Mill
Choose your milling tool.

MILL CLimb OR Conventional : CL
Width of cut: .3125

FINISH ALLOWANCE : 0.02

Pick the large pocket.

FINISH DEPTH: .5
DEPTH OF CUT: .5
PICK EXTERIOR CONTOUR:

Generate path for roughing area using zig-zag motion

Variational: VMill - Rough - Zigzag pocket
TOOL : .500 Endmill

MILL CLimb OR Conventional : CL

WIDTH OF CUT : 0.3125
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FINISH ALLOWANCE : 0.02
ANGLE OF ZIGZAG LINES : 0
Pick the line on the right hand side of the small pottkelefine the angle of cuts.

PICK EXTERIOR CONTOUR:
Pick the small pocket.

NUMBER OF ISLANDS : 0
FINISH DEPTH: .5
DEPTH OF CUT: .5

Cutter offset with full look ahead

Variational: - Vmill - Path > Finish Mill w Leadin
TOOL : .500 Endmill <OK>

SELECT Leadin type: 1

SELECT Leadout type: 1

MILL CLimb OR Conventional : CL

FINISH ALLOWANCE : 0.02

PICK AN ELEMENT OF CONTOUR TO BE OFFSET:

Pick the outside contour, then pick to the outside ofdbatour.

FINISH DEPTH: .5

Modify Offsets

Edit offset data

Vatiational: - Vcontrol - Edit > Record Free Parameter

PICK VARIATIONAL RECORD, NUMBER?

Pick the outside contour cutter path. This will bring upli$ieof variables used in this record. Pick “Depth
of Cut” from the selections box. At the prompt lieater a new value for the variable. Enter “.25.” The
click “Refresh” from the prompt line.

Next, pick the Large pocket cutter path. Then click thed/pf Cut” variable. Change this variable’s
value to .28, and click “Refresh” from the prompglin

Create Tool Symbols

Create tool geometry

Create the tool geometry the same way you did in exeonise
Images> Make All Mill

Archive
Main Menu: File=> Archive > Save—~> Archive

Choose a Material

This step may not be necessary, particularly if yoletedready selected a material when you loaded the
hole features.

Design: Mill - Tools - Choose a Material

Recalculate for Feeds and speeds
Design: Mill - Tools - Recalculate
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Group holes according to associated tool

Design: Group - Create - Tool
INPUT TOOL ID NAME : .5000 spotdrill
GROUP NAME : sdrill

INPUT TOOL ID NAME : #7 Twist Drill
GROUP NAME : 7drill

INPUT TOOL ID NAME : .250_20NC Tap
GROUP NAME : tap

INPUT TOOL ID NAME : CANCEL

Generate NC code for applicable machining

Design - Mill - Execute - Turbo Post

TURBO POST NAME : globalhmill

SELECT COMMAND FILE TYPE : NEW

SELECT POST FUNCTION : SELECT POST COMMAND
SELECT COMMAND : 1 STARTUP:

ENTER THE PROGRAM DESCRIPTION : exercise 2
ENTER THE PROGRAM NUMBER: 2

ENTER THE TOOL NUMBER: 1

ENTER THE NEXT TOOL NUMBER: 2

ENTER THE INITIAL Z VALUE: 1.0

TOOL DESCRIPTION : .5000 spotdrill

SELECT COMMAND : DRILL:

PICK STARTING HOLE, Sequential, Group, Manual, Proc
PICK HOLE GROUP, Proceed :

Pick one of the grouped holes shown.

PICK HOLE GROUP, Proceed : P

SELECT COMMAND : TOOLCH:

NEXT TOOL NUMBER 3

INITIAL Z VALUE: 2.0

TOOL DESCRIPTION : #7 Twist Drill

SELECT COMMAND : PECK_DRILL:

PECK DISTANCE : .12

PICK STARTING HOLE, Non-sequential, Group, Manual,
PICK HOLE GROUP, Proceed :

Pick one of the grouped holes shown.

PICK HOLE GROUP, Proceed : P

SELECT COMMAND : TOOLCH:

NEXT TOOL NUMBER: 4

INITIAL Z VALUE: 1.0

TOOL DESCRIPTION : .250_20Nc Tap

SELECT COMMAND : TAP:

PICK STARTING HOLE, Non-Sequential, Group, Manual,

Pick one of the grouped holes shown.

PICK HOLE, Sequential, Group, Manual, Proceed : P
SELECT COMMAND : TOOLCH:

NEXT TOOL NUMBER: 5

INITIAL Z VALUE: 1.0

TOOL DESCRIPTION : .750 Spot Drill

SELECT COMMAND : DRILL:

eed: G

Proceed : G

Proceed : G
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PICK STARTING HOLE, sequential, Group, Manual, Proc eed :

Pick the hole shown.

PICK HOLE GROUP, Proceed : P
SELECT COMMAND : TOOLCH:

NEXT TOOL NUMBER: 6

INITIAL Z VALUE: 1.0

TOOL DESCRIPTION : .4062 Twist Drill
SELECT COMMAND : PECK_DRILL:
PECK DISTANCE : .12

PICK STARTING HOLE, Sequential, Group, Manual, Proc eed :

Pick the hole shown.

SELECT COMMAND : TOOLCH:

ENTER THE NEXT TOOL NUMBER: 8
INITIAL Z VALUE: 1.0

TOOL DESCRIPTION : .625 Counterbore
SELECT COMMAND : COUNTERBORE:

PICK STARTING HOLE, Sequential, Group, Manual, Proc eed :

Pick the hole shown.

SELECT COMMAND : TOOLCH:

NEXT TOOL NUMBER: 9

INITIAL Z VALUE: 1.0

TOOL DESCRIPTION : .500 Endmill

Z FEED RATE: 2.57

SELECT COMMAND : CUT_PATH_GRP:

PICK PATH, Proceed :
Pick the large pocket cutter path.

PICK PATH, Proceed : P
SELECT COMMAND : CUT_PATH_GRP:
PICK PATH GROUP, Proceed :

Pick one of the grouped small pocket cutter paths.

PICK PATH GROUP, Proceed : P
SELECT COMMAND : CUT_GRP_PGRPS:
PICK PATH, Proceed :

Pick the outside contour cutter path.

PICK PATH, Proceed : P

SELECT COMMAND : 2 END_CODES:

SELECT COMMAND : CANCEL

SELECT POST FUNCTION : EXECUTE COMMAND FILE
SELECT POST FUNCTION : CANCEL

Show Documentation
Main Menu: Misc> NC Docs

The NC docs will show you a Time analysis, ToolingtLCost analysis and the NC tapecode.
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Archive
Main Menu: File=> Archive > Save—~> Archive

Export the Current tape file
Main Menu: File> Export—> Current Tape file

Choose you post processor, or select Copy File. Thiseply the tapefile t€: \usr\weber\ST\tapesand
allow you to rename the tapefile.

Running AMO

Use Automated Manufacturing Output as a pre-processor

Using the Automated Manufacturing Output is by far theesasind fastest method of generating your
CNC code. However, any changes you wanted to make to tGec@8ie using AMO must be made
manually. You can use AMO as a pre-processor in cotipgmuesith Turbopost to greatly reduce the
amount of manual editing you may need to do. Begin by rurkin@ on this exercise the same way you
ran it in exercise two.

Manually Sort your Tasks
Design: Mill - Tasks - Sort

Mill the part

Choose the Horizontal AMO execute by clicking: Desigredtite> Global Hmill

AMO creates the command_file automatically based ogédbeetry and tooling information. You can use
AMO to create the command_file, and then take that iregtst processor to make any edits you may
need. It's faster than running Turbopost manually because igieo need to pick commands off the menu

or choose the geometry that you need to machihwerytime you execute AMO the command_file is over
written.

Making edits to the command file
Bring the command_file into Turbopost to perform anysedit

Design: > Mill - Execute - Turbopost
CHOOSE POST FORMAT :
Choose the “globalhmill” post format from the seleas box.

CHOOSE COMMAND FILE TYPE : EXISTING
This will bring in the command_file that AMO just created.

SELECT POST FUNCTION : EDIT - EDIT COMMAND FILE

You can then execute the command file in Turbopost andykespchanges.

Synergy Training 53 Weber Systems, Inc.



Synergy Mill

Data Exchange

IGES

IGES is an acronym fdmitial Graphics Exchange Specification, an ANSI graphics file format for three-
dimensional wire frame models.

Import

You are going to start by importing an IGES File. Fromrtiain menu, find and click File Import >
IGES> New

The prompt line will ask you:

THIS ERASES THE CURRENT JOB LOAD Yes/No ? REP = Y

This is a safety mechanism. When you import an IGESS§inergy assumes that you are starting from
scratch. Any data that you might have on the screemeébgém clicked the Import IGES button will not be
saved once you answer “Yes” to this question.

When you choose your file from the box that comestupoks in that file to see whether certain attrilsute
have been set.

Click on or type <Y> and press <Enter>. The prom liwill instruct you:

CHOOSE EXISTING IGES FILE FROM FILE BOX

Synergy will present you with a file dialog box where yall locate the file you want to open.. You may
need to use the scroll bars and scroll the list@ffames until you find it.

Reading the IGES Global Data

After Synergy has imported an IGES file, it will displaynergy's IGES global data window. This window
gives you information about the file, including product idesgtion, the name, the system filename,
translator version, creation date, the scale, &S version number, and so on.

If you scroll down this information using the scrolkdan the right side of the global data box, under a
section headed “Entity Totals,” you may also see infdion about the geometric entities contained in the
file. For example, an IGES type number 100 is a cigezid, it will give you the entity count of what it has
just imported.

Look at the bottom of the list, you'll see a key to uistianding the markings that may or may not appear
next to the entity listings.

The key says: “* these entities are not translataa’“a these entities are only partially translated.”

This means that when an entity is marked with aniaktéy), Synergy is indicating that the information
was contained in the original IGES file, and for whateeason, Synergy was unable to read it. This could
be because the entity contained corrupt data so itkigsesl. If an entity is marked with a plus sign (+), it
indicates that the entity was read, but it may not heesn translated on a 1-1 basis. Normally, this is
because the original file contained a custom coloa, @lor that’s not directly translatable accordinghte
IGES standards. In this case, Synergy will translatenifiermation to the nearest similar Synergy color.

Once you have looked at the IGES global data windowgcgouprint the information if you find it
important, or you can click Cancel, and move on.
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The IGES Widget

The IGES widget is a tool that gives you the abilitgetect which parts of an IGES file you want imported
into Synergy. You have the option of not using this widgetiarporting the file in its entirety, however,
there may be certain entities in some files that dsete any purpose when imported into the Synergy
environment. The IGES widget lets you choose not to itthese entities.

The variable for turning the IGES widget on and off barfound in Synergy’s main menu. Click Settings
- Variables. Look for the variable named: “use IGES widge

A switch box called the IGES WIDGET (program name: igsget) is available through the named
variable "use IGES widget". When "use IGES widget" is®éyes"”, the widget will be run, while a value
of "no" indicates that the widget is not in use.

When you are running the widget, it will start automaiiyoahen you attempt to import an IGES file.

More information is available in the IGES widget hid#pflocated in
usr/weber/filing.d/importigs

1 1gs_widget M=)
Eile  Optionz  Help
—IGES File Selection
Input IGES file name:l Browse. .. |
Cutput Synergy file name:ligsnut j Browsze. .. |
Fiepart; IEr'ltit_'.-' totalz j
ak. | Cancel |

The IGES widget
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Using the IGES widget

The IGES widget consists of a select box with a menulG&S file name selection line, Synergy file
name selection line, Synergy name option menu and an oafprt option menu.

IGES widget menus: Options
Filters:

Brings up a window where you can pick and choose how you Migaltb filter six different aspects of an
IGES file: including Surfaces, Drafting, Propertie®/ Trims, XYZ Trims, Dependencies.

Trimming:

Brings up a window where you can select how you wouldSikeergy's IGES translator to treat the
trimming methods used on five surface types (Nurbs, RewalitiTabcyls, Parasplines, and Ruled).
Special:

This brings up a dialog box that lets you control misoekas options. You can set the IGES translator’s
Tolerance factor, Entity timeout, Convert nurb saiégree, and determine with which directories and
entities you would like the translator to skip.

Synergy Training 56 Weber Systems, Inc.



Synergy Mill

IGES Entity Types

100
102
104
106
108
110
112
114
116
118
120
122
124
126
128
140
142
144

Circle

Composite curve

Conic arc

Copious data - Linear path - Simple closed pla
Plane

Line

Parametric spline curve
Parametric spline surface
Point

Ruled surface

Surface of revolution
Tabulated cylinder
Transformation matrix

Ration b-spline curve

Ration b-spline surface

Offset surface

Curve on a parametric surface
Trimmed parametric surface

IGES Annotation Entites:

202
204
206
208
210
212
213
214
216
218
220
222
228

Angular dimension
Curve dimension
Diameter dimension
Flag note

General label
General note

New general note
Leader

Linear dimension
Ordinate dimension
Point dimension
Radius dimension
General symbol

IGES Structure Entities

308
402
404
408
410

Subfigure definition
Associativity instance
Drawing

Subfigure instance
View

nar path
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DXF

DXF is an abbreviation dbata Exchange File, a two-dimensional graphics file format supported by
virtually all PC -based CAD products. It was created\btoDesk for the AutoCAD system.

DXF is a very verbose, ASCII text representation ofea There are four parts to a DXF file. The
HEADER section defines values for most AutoCAD systamables. Most of these are not useful for
another CAD system. The TABLES section defines itkkesline styles and user-defined coordinate
systems. The BLOCKS section contains the definitmigocks instanced in the model. The ENTITIES
section contains the entity definitions and blockanses. Using AutoCAD it is possible to create a valid
DXEF file that only contains an ENTITIES section.

Problem Elements with DXF Elements Missing From DXF
e Text e Solids
» Splines * Nested Shape
* Views e  Offset Curve
e Surfaces »  Curve on Surface
* Dimensions e Chain Dimension
* Fill Patterns e Curve Length Dimension
* Properties e Grid
Import

Synergy is capable of reading DXF ASCII data files iméted way.You can not export DXF files from
Synergy.The following are instructions for importing DXF data:

You are going to start by importing an DXF File. Fromrtegn menu, find and click Fil& Import >
DXF. The prompt line will ask you::

SELECT DXF FILE:

The selection box will appear, from which you will findddiocate your file. The prompt line will ask you:

Undo or Merge:
Enter "U" to undo (delete) the file placement. Enter thlifinalize the merge. Merge must be selected to

finalize the procesgiou will not import the file if you do not choose merg! The prompt line will ask
you:

DELETE REFERENCED BLOCKS (Yes or No):

Some DXF files may have conflicting data in their BLK generation and insertion group codes.
Alternating responses to this question may solve thisigm
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Libraries

Synergy comes with an extensive tools and materktadsriy.

Tools

The tool library is located in:usr/weber/util/tooldata /. Each set of tools is separated into the
following directories:

Directory Tools

tools_in inch-based milling tools

tools_mm metric milling tools

[tools_in inch-based lathe tools

[tools_mm metric lathe tools

The tools are then further subdivided into categories ¢ tuased on the type of machining each tool are

used for.

Creating custom tools:

You should only ever make changes to copies of the tosl fileat way, you won’t overwrite the tool files
that came with Synergy. We suggest copying an entirelieattory and renaming it. For example, if you
are going to make custom inch-based tools, copy the émie in directory, and give it a custom name,
like: custom_in. Then you need to tell Synergy to run your ocustom library by:

1. Modify the default values for the libraries in /ushe&r/ascrpt/setconstants. Then copy
setconstants to /usr/weber/contrib/ascrpt/. Synergylaak under contrib for setconstants first.

2.

Add the directory paths for the librariestsr/weber/ascrpt/userconstantsThen copy
userconstants taigr/weber/contrib/ascrpt/. Userconstants gets read in after setconstants
and never gets modified by us.

Add the library directories to a Cad setting file egal it in when starting a new job. Copy
/usriweber/database/properties/CadSettings.d/default_ito another name. Add the
following line:

SystenVars.tools dir: /usr/weber/util/tool data/tools_in/

Change tools_in to be your customtool library directory.

Steps to Create a Mill Tool

o > w N PE

Chooséedit>Tool_library 2 Createlib tool

Pick the tool category from the selections box.

Choose a tool that's similar to the tool you wantreate.
Make changes to the data in the pop up create toolblisk. @K

Save the changes you've made. If you haven't givetotii@ unique file name, Synergy
will ask if you are sure that you want to overwrite triginal file.
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Utility Kits
Utility Kits are special menus that you can create@rsiomize with your own buttons.

Utility Kits allow you to instantly and effortlesshuild your own menus "on-the-fly." You can either copy
existing buttons or add new ones to your own menus. @maecustom menu is complete, you can save it

for use in future Synergy sessions. It will be avadadilany time via Synergy A menu.
Create a Utility Kits
Edit - Interface - New Utility Kit

To create a menu, choose New Utility Kit. Type il and a new kit filename.
Click on CREATE.

You will then see a small box appear in Synergy. Thisasiew utility kit. Start adding buttons.

Add a Button to your new utility kit

Copy an existing button
Choose Edit - Interface - Copy a Button

1. Click on the button that you want to copy. This wi#tate a “floating” button.

2. Drag the “floating” button and drop it into the Ugilkit you want the button to
appear in.

Delete a Button
Edit - Interface - Delete a Button

Click on the button that you want to delete. Be suredsecthe Delete Button Dialog box when you are
finished deleting buttons.

Delete a Utility Kit
Edit - Interface - Delete Utility Kit

1. Choose Edi©®> Interface> Delete Utility Kit.
2. Click the title bar of the utility kit that you watd delete.
Special Rules for Utility Kits:

You can not create a button that will toggle system fanst “On/Off” Toggle buttons are not supported
and may crash the system. This feature is designetiafodard button functions only.
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System and User-Defined Hot Keys

HotKeys allow a user to enter a combination of keysgdkde used as a hot key, which enables users
to perform an action quickly.

Synergy provides a HotKey editor that allows users tanddfbt keys. A hot key is a key combination
that sends a message equivalent to pressing a buttoexdraple, by defining a hot key consisting of
the CTRL+T key combination, a user could draw a Top View

To define a hot key, use the HotKey editor to speciéydbmbination of keys that will generate the
desired action. The HotKey editor can also be used efer@mnce to view the current hotkey actions.

There are many predefined hotkey combinations callsteByhotkeys. For example, CTRL-H brings
up the HotKey editor. The System hotkeys cannot be aldemi by user hotkeys.

Using the HotKey Editor
The Copy/Add Button functions are available in Tlo®ls drop-down menu in the HotKey editor.
++ Using the Utility Kit Copy Button function:

Users can copy existing interface buttons to Utilitiskir the HotKey editor. When Copy function is
used, a copy of the button appears under the cursor amndeh can drag the button to the desired
location. The HotKey editor will fill in the Name ardttion fields with the information in the button.

++ Using the Utility Kit Add Button function:

The Utility Kit "Add Button" function can be used to suppitg name and action fields for a HotKey.
This function also creates a draggable button that eaindpped in either editors or kits.

++ Defining the key combination:

To complete the HotKey definition, the user only neteddick the HotKey combination box and then
press an unused combination of Shift/Ctrl/Alt and oherokey. Any combinations already in use will
not be displayed.

After all three fields are filled in, the user can useAbd button to append the HotKey to the user
HotKey list.

A HotKey can also be defined by filling in all threeldi® manually.
++ Clear key

The Clear key clears the Combination, Name and Adibds.

++ Delete key

If the Combination, Name and Action fields exist in therddotKey list, the Delete key will remove
the entry from the list.

++ OK and Cancel buttons

Clicking OK will save any changes to the user HotKety @mncel abandons any changes made since
the HotKey editor was first brought up.
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Copyrights

© 1992-2006 Weber Systems, Inc. All rights reserved. Nogdahis publication may be reproduced,
transmitted, transcribed, stored in a retrieval systertranslated into any language in any form by any
means without the express written consent of Webdei®gs Inc.

Weber Systems, Inc.
W134N5514 Campbell Drive

Menomonee Falls WI 53051

Synergy is a trademark of Weber Systems, Inc. All dth@nds or products are trademarks of their
respective holders and should be treated as such.

Restrictions

Synergy CAD/CAM Automation software is protected byd¢bpyright laws and international treatises that
pertain to computer software. You may not translate, oerlease works based upon the Software or any
part thereof.

Notes

Some of the images used in this manual are based orvegsigns of the product. While we have made
every attempt to keep these images as up to date as poggbé may be some cosmetic differences
between what you see on your screen and what isicedte this tutorial.

For more information on this or any other course thab®/ Systems offers, including cost, schedule and
registration, please contact Weber Systems support @ihmew.webersys.copor call Weber Systems at
(262) 782-0181

Course content, prices, and availability are subjechtmge without notice.
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